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Copyright 2024 killihu. All rights reserved.

The content of this manual is furbished for informational use only, is subject to change without notice, 
and should not be construed as a commitment by killihu. Every effort has been made to ensure that 
the information in this manual is accurate. killihu assumes no responsibility or liability for any errors or 
inaccuracies that may appear in this book.

Ableton is a trademark of Ableton AG. Max for Live is a product developed by Ableton AG in 
cooperation with Cycling '74. Mac is a trademark of Apple Inc, registered in the U.S. and other 
countries. Windows is a registered trademark of Microsoft Corporation in the United States and 
other countries.

killihu is not a partner of Ableton AG or Cycling'74.

This book has been inspired by the Ableton Live Reference Manual, with the aim of making it easier 
for Ableton Live users to read.
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Main information

1.1 Plugin Overview

This plugin adds new buttons/controls and new features to work with Ableton Live.

It consists of a button bar with a transparent background, where different button configurations 
can be created. The button bar can be positioned anywhere on the screen.

Main features:

• Adjustment of clip parameters without having to open the clip detail view, such as 
volume, transposition, groove selection and others.

• New mode to capture and insert scene.
• Global activation and deactivation of tracks.
• Alternative way to move loop markers in the arrangement.
• Automatic reset of overwritten automation when starting or stopping transport.
• Automatic unfolding of the track selected in the arrangement and folding the other tracks.
• Track colors to clips for all tracks in the project.
• Volume, Pan and Send controls for the selected track.
• Session view clip duplication and triggering of the new duplicate clip.
• Switch between different Live color themes without opening the preferences window.
• One-button access to various Live actions that are only available in context menus.
• Creation of presets with different layouts that can be loaded using key mapping.
• Button/control size adjustment to fit any screen resolution.
• Supports multi-monitor setups.
• Does not interfere with Live's undo history.
• Matches Live's color theme.
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1.2 System Requirements

• Live Version: 10 / 11 / 12 with Max for Live

• Operating System: Windows

1.3 Installation Instructions

Unzip the ZIP file and copy the plugin amxd file to your User Library folder. There are two ways 
to find where your User Library is located:

Go to Preferences – Library – Location of User Library

Or [right-click] on the User Library in the Browser – Show in Explorer

1.4 Limitations

• The MIDI note transpose and clip groove selection functions do not work in Live 10.
• The button to expand the clip editing view does not work in Live 10.
• The freeze track button only works in Live 12.
• Live's color theme change feature only works if the OS zoom is at 100%. That is, the 

zoom level set in Windows options, not in Live preferences.
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Controls

2.1 Rack Controls

On the device rack is the button to show/hide the menu bar. This button can be mapped, 
allowing you to assign a keyboard key to show and hide the menu bar.

The Settings button shows the configuration options of the device.

An icon is displayed at the bottom of the device rack. Clicking on the icon shows the version of 
the device. When a new device update is available, a message will be displayed indicanting it.

2.2 Settings

Shows positioning options, button modes, color themes and presets.

2.2.1 Positioning

To position the button bar on the screen, when you activate the Visual Aid 
button, the background of the button bar is no longer transparent. This helps 
position it on the screen.

The Pos X and Pos Y controls set the position of the button bar in pixels. 
Negative values can be set for adjustments in multi-monitor setups.

The Width control sets the size of the button bar, and the Zoom control allows you to adjust the 
display if the Zoom Display setting in Live is other than 100%.

Since the button bar can be used with 4K resolutions, for fine adjustment of positioning values it 
is advisable to hold [Shift] when changing them using the mouse. And finish the adjustment using 
the arrow keys on the keyboard.



Advanced Toolbar Buttons Reference Manual     8

2.2.2 Button Modes

To the right of the positioning controls are the button mode controls. Some buttons have different 
modes of operation. Later in this manual, in the description of the buttons, it is detailed how these
options work.

2.2.3 Color Themes

The background color of the buttons does not automatically adjust to the Live color theme. With 
these controls the color can be set using the boxes (in RGB format) or using the Color Picker 
button. When the Color Picker icon is activated, clicking anywhere on the screen takes the color 
under the mouse pointer.

The device has 2 color themes in case you use the functionality of the Theme Light and Theme 
Dark buttons, detailed later in this manual. The Light Theme setting is the default color.

2.2.4 Configure Buttons

The Configure Buttons button displays a floating window where the buttons/controls to be 
displayed in the button bar are activated and positioned.

An activation button and a positioning control are shown for each button/control. To add 
buttons/controls to the button bar, simply activate the button and change the position value to 
move them horizontally across the button bar.

2.2.5 Presets

It is possible to save different presets that contain the positioning values of the device and the 
configuration of the buttons displayed in the button bar. They can be loaded using mapped keys.

This way different button bars can be created for different tasks. Or different setups if you work 
with several computers, for example laptop and desktop.

Note that each time a preset is loaded adds a few steps to the undo history.
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Button description 

3.1 General

Auto Expand Tracks

The Auto Expand Tracks button adds new functionality when working in the Arrangement View, 
when activated automatically unfolds the selected track while folding the other tracks in the 
project.

This feature is still under development. The following must be taken into account:

• The cursor must be placed over the track when selecting it. If the cursor is placed 
between the separation of two tracks (when the cursor changes to indicate that the track 
resize action will be performed) the track will not be automatically unfolded.

• Works for tracks and tracks within a group track. It does not work for group tracks that 
are inside another group track.

• Has a bug that sometimes causes the selected track to move one position down in the 
track list. Happens if all tracks are unfolded when activating this function, or when tracks 
have automation lanes added.

Auto Restore Automation

When the Auto Restore Automation button is active, the overridden automation will be 
automatically reset when starting and stopping the transport.

Hide Device

This button hides the button bar. It works the same as disabling the Show button on the device 
rack.

MIDI Record Quantization

Sets the MIDI input quantization in the same way as in the menu: Edit - Record Quantization.
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Theme Dark Theme Light

Since many users often use two color themes in Live, one light and one dark, with these buttons it
is possible to change the color theme without having to open the Live preferences window.

The device performs the color theme change using the kDT.exe application, which is detailed 
later in this manual.

Unfold Tracks

This button folds/unfolds all tracks in the Arrangement View. Performs the same function as 
pressing [Alt] + [U].

3.2 Create

Capture scene

This button captures the currently playing clips and insert them as a new scene.

In the device rack you can select between two different scene capture modes. 

• In default mode the new scene is inserted after the currently selected scene.
• In alternative mode the new scene is inserted at the end of the scene list. The selected 

scene focus will remain on the selected scene.

Insert Empty MIDI Clip

This button inserts a MIDI Clip in an empty Session slot or, in the Arrangement View, in a 
selected timespan in a MIDI track.

Insert Audio Track Insert Return Track

Insert MIDI Track Insert Scene

The other buttons perform the insertion of empty tracks and empty scenes.
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3.3 Export

These buttons perform the Export Audio/Video and Export MIDI actions found in the File menu.

Export Audio Export MIDI

3.4 Clip

These buttons/controls perform actions on the selected clip. For both audio clips and MIDI clips.

Clear Envelopes

This button removes all envelopes from the selected clip. It only acts on automation envelopes in 
the session view. It does not act on modulation envelopes and MIDI control changes.

Hopefully Max for Live is updated so that this feature also applies to modulation envelopes and 
MIDI control changes.

Crop

This button crops the clip: if the clip is looped, the region outside the loop is removed; if it isn’t, 
the region outside the start and end markers.

Duplicate & Play

This button duplicates the selected clip in the Session View and triggers the duplicate clip.

Expand View

This button toggles between the fully expanded Clip View and default Clip View sizes.  Performs 
the same function as pressing [Ctrl] + [Alt] + E.

Groove

Select the groove used for the selected clip from the grooves available in the Groove Pool.
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When no clip is selected the Groove control will not be accessible.

Due to limitations in Max for Live, it is currently not possible to select None via the Groove 
selector. To deactivate the Groove of the clip, do it from the Clip Detail View. 

Loop Switch

This button turns on/off the Loop switch of the selected clip. When no clip is selected this button 
will not be accessible.

Quantize

The Quantize button displays a dropdown menu to select and apply the desired quantization to 
the selected clip.

3.5 Audio Clip

These buttons/controls perform actions on the selected audio clip. When no clip is selected, or 
the selected clip is a MIDI clip, these buttons/controls will not be accessible.

Gain

The Gain control adjusts the clip’s sample playback volume in decibels (dB). It has a small 
deviation between 0.01dB and 0.04dB when setting some negative values. 

RAM Mode

If the RAM button is on, Live loads the audio referenced by the clip into memory, rather than 
reading it from the disk in real time.

Transpose (st)

This control adjusts the sample pitch transposition in semitones.

Transpose (ct)

This control adjusts the sample pitch transposition in cents (100 cents = 1 semitone).
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Warp Mode

The Warp Mode control sets the time-stretching method. REX mode only works if the sample file 
is in REX format.

Warping

When the Warping button is activated, the sample is time-stretched using Warp Markers so as to
play in sync with the current song tempo.

3.6 MIDI Clip

These buttons perform actions on the selected MIDI clip.

Duplicate Loop

The Duplicate Loop button duplicates the MIDI clip loop and doubles its length.

Note Down Note Up Octave Down Octave Up

The Note Down and Note Up buttons transpose all notes in the MIDI clip in 1 semitone intervals.

The Octave Down and Octave Up buttons transpose all notes in the MIDI clip in 12 semitone 
intervals.

For the transpose actions to work correctly, the MIDI clip's start marker must be positioned at the 
beginning of the clip.

3.7 Track

These buttons/controls perform actions on the selected track.

Color to Clips

The Color to Cips button assigns the track color to all clips on the track.
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In the device rack you can select whether the color assignment will be applied to all tracks in the 
project or only to the selected track.

Freeze

Freeze the selected track (only works in Live 12).

Pan

Send

Volume

Pan, Send, and Volume controls perform the same way as the mixer controls. Send controls 
available for Sends A to F.

In the device rack you can select the display of the colored slider for this controls. It also applies 
to the Clip Gain control.

3.8 Track Activation

These buttons perform track activation/deactivation actions globally.

Activate/Deactivate

The Activate/Deactivate button works as follows:

• When any track is deactivated, pressing the button activates all deactivated tracks.
• When all tracks are activated, pressing the button will deactivate all tracks.

Unsolo All Tracks

The Unsolo All Tracks button disables the Solo button for all tracks.
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In the device rack you can select which tracks the Activate/Deactivate button affects. You can 
select all tracks or exclude return tracks.

A/S Return Tracks

With the A/S Return Tracks buttons you can mute or solo all return tracks at once.

3.9 File

These buttons perform actions found in the File menu.

New Set Open Set Save Set Save Set As

3.10 Edit

These buttons perform actions found in the Edit menu.

Undo Cut Paste Split

Redo Copy Duplicate Consolidate

3.11 Loop

These buttons perform actions related to moving the loop selection in the arrangement view.

Loop Backward Loop Follow Play Loop Forward

Loop Backward and Loop Forward moves the loop markers in the arrangement by a time equal 
to the size of the loop.

When the Loop Follow Play switch is active and the transport is running, the playback position 
follows the position of the first loop marker.
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Arrangement Controls

4.1 Description

There is a second device included in the downloaded ZIP called Arrangement Toolbar Buttons. 

The button bar for this device is only displayed in the Arrangement View. It is automatically 
hidden in Session View. Its purpose is to place buttons/controls above the track list in the 
Arrangement View.

4.2 Settings

The configuration of this device is done the same as with the other. The only difference is the 
process for positioning the buttons/controls.

Instead of using a floating window, the controls for activating and positioning the buttons are 
located on the device's rack. As this device allows you to create several lines of buttons, a 
vertical positioning control for the buttons has been added.

The buttons/controls available on this device are:

• Auto Expand Tracks
• Insert Empty MIDI Clip
• Unfold Tracks
• Activate/Deactivate Tracks
• Unsolo All Tracks
• Track Color to Clips
• Track Freeze
• Track Pan
• Track Sends (A to F)
• Track Volume
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killihu Device Tool

5.1 App Overview

kDT (killihu Device Tool) is an app for Windows that performs the tasks of changing the color 
theme, and hiding/showing the device when using the Fancy Menu Bar device. It must be 
running while using the device for those features to work.

If you are not going to use Live's color theme changing features and the Fancy Menu Bar device,
you do not need to use this app.

5.2 Installation Instructions

Extract the downloaded ZIP file and run the kDT.exe file to start the app. An icon will appear in 
the system tray. To close the app, right click on the system tray icon and select Exit.

The app only works when Live is running and does not interfere with other open applications.

5.3 Settings

The first time you run the app the settings window will be displayed.

Clicking the OK button will create a kDT.ini file with the app 
configuration.

The settings can later be accessed by right-clicking on the system tray 
icon.
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5.3.1 Ableton Live Version

The app works differently to fit each version of Live. Make sure you choose the version of Live 
you are using. Available options: Live 10, Live 11 and Live 12.

5.3.2 Device Show Key

This setting is used to hide/show the device when using the minimize 
and unmaximize buttons of the Fancy Menu Bar device.

The same key assigned in Live to show the device must be indicated in 
this field. If in Live a key has not been assigned via Key Map to the 
device show button, the device show/hide function will not work.

This field is case sensitive.

If you don't use the Fancy Menu Bar device, you can skip this setting.

5.3.3 Theme Position

For the color theme change buttons to work, the position of the two 
chosen color themes must be indicated in these fields.

To know the position of the color themes, open the Live preferences 
window and display the theme selection menu. You can get the 
position of the themes as shown in the example screenshot.

To change the theme, the app automates the mouse and keyboard. It is advisable not to move 
the mouse after clicking the color theme change button.

This feature only works if the OS zoom is at 100%. That is, the zoom level set in Windows 
options, not in Live preferences.

If you are not going to use the buttons to change Live's color theme (Light Theme and Dark 
Theme buttons) you can skip this setting.
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5.4 Antivirus Warning

The app contains an AutoHotKey script. Years ago all antiviruses detected these scripts as 
viruses/trojans due to their characteristics. Currently, most antiviruses have been updated and 
detect that AutoHotKey is safe, although some still do not.

You can upload the exe file to virustotal.com and you will see that all the major antiviruses mark 
it as safe. Only a few showing it as unsafe, which is known as a false positive.

If your antivirus blocks the app from running, add the exe file to the exceptions list.
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Additional Info

6.1 Fancy Menu Bar Compatibility

Advanced Toolbar Buttons is compatible with the Fancy Menu Bar device.

Fancy Menu Bar has a system to hide the device's floating elements when using the minimize 
and unmaximize buttons, and to automatically show them again when the Live window is 
maximized.

This functionality also affects Advanced Toolbar Buttons and Arrangement Toolbar Buttons. So 
they will be hidden/shown at the same time as Fancy Menu Bar.

Also the actions of the Theme Light and Theme Dark buttons will be applied to both devices. 
Regardless of which device they are used on, the color theme changes will also be applied to 
the other device.

The external app kDT.exe included in the ZIP file is the same for both devices. So you must use 
the same key mapping to show/hide the devices.
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6.2 Version 1.0 for Mac Users

Starting with version 2.0, the device no longer has compatibility with Mac OS. This is because 
some Max functions related to window properties do not work in that operating system, and 
others work but do so in a randomly incorrect way.

Version 1.0 of the device is still available for download for existing users.

This version has problems in recent versions of Mac OS when configuring the position of the 
buttons on the screen. It happens that by having some buttons positioned, when activating the 
display of a new button, the previous buttons change size and/or position.

To configure the buttons correctly, you basically have to first activate the display of all the 
buttons you want to use, and then set their position on the screen using the arrow keys on the 
keyboard instead of the mouse.

• Load the device (.amxd) and first activate all the buttons you want to use.
• Set the position of each button. To do this, click on the X and Y parameters of each button

and use the keyboard arrows to change the values (if you hold down the [Shift] key you 
can move them faster).

• Save a device preset with your settings. Delete the device and load the preset you have 
saved.

• If when loading the preset the buttons appear vertically displaced from the position 
where you placed them, modify the Y position parameter of each one again and save 
the preset again.

This (tedious) procedure sometimes requires auto-hide of the OS menu bar to be enabled in 
system preferences.

Note that the default position of the buttons is x0, y0 (top left of the screen). In that position they 
appear under the operating system menu bar. The vertical position of the buttons must be 
changed for them to appear on the screen.
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